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GETTING STARTED 

Welcome Wizard 

If no earlier versions of ProVAL are installed, the first time the software is started a welcome screen will ask 
you some basic questions: 

Unit System  Checking the “Use SI Units” would enable SI unit system, otherwise the 
application will be in USCS unit system.  
Enable Recording Log  Check this option to help with reporting bugs by saving logs of 
software operations. 
Preferred Language  Select a language for display.  Currently only English is available. 
Default File Type  Select the default file type when adding profile data. 
Default Project Path  Select the default project path to speed up file lookup. 

This gives you a convenient way to specify preferences.  The Welcome Wizard only shows once after each 
installation.  You can also modify those settings later on by using the Options dialog box. 

Behavior of User Interface 

The following describes the behavior of the ProVAL Graphical User Interface (GUI): 

The window position is saved. 
The software complies with Section 508 accessibility requirements. 
Allows you to minimize navigation elements and analysis inputs to maximize screen real-
estate. 
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初期設定ウィザード

ソフトウェアをはじめて起動したときに、ProVALの初期バージョンがインストールされて
いない場合、初期設定画面がいくつかの基本的な質問を尋ねてきます: 

Unit System（単位系）－『Use SI Units（SI単位を使う）』をチェックすると SI単位系
になり、それ以外の場合、アプリケーションは USCS単位系になります。
Enable Recording Log（ログの記録を可能にする）－このオプションをチェックすると、
ソフトウェア操作のログが保存され、バグ報告の助けになります。

Language（言語）－表示言語を選択します。現在は英語のみ利用可能です。
Default File Type（ファイル形式）－プロファイルデータ追加時の既定のファイル形式
を選択します。

Default Project Path（保存先）－検索を早めるために既定の保存先を選択します。

これは、優先順位を指定する場合に便利です。初期設定ウィザードは、インストールの後に

一度だけ表示されます。さらに、オプション・ダイアログ・ボックスを使えば、それらの設

定を後で修正することができます。

ユーザ画面の機能

以下に、ProVALグラフィカル・ユーザ・インターフェース（GUI）の動作を示します：
ウィンドウ位置が保存されます。

ソフトウェアはアメリカのリハビリテーション法第 508 条におけるユーザ補助規定を
遵守しています。

ナビゲーション要素と解析時の入力を最小限にし、画面サイズの制限を最大限にします。

ProVAL ユーザーガイド / 始める 

スタートする前にいくつか基本情報が必要です。ProVALのカスタマイズが
できます。これらの設定は Options画面でいつでも変更できます。 
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Home Screen 

This is the starting screen when no project is currently open.  It consists of three main sections: the toolbar, 
Recent Projects, and ProVAL Online (if the Internet is accessible and the “Show Online Content on the 
Start Page” is selected in the program Options screen). 

Page 13 

ホーム画面

これは、プロジェクトが開いていない場合のスタート画面です。3つのセクションで構成さ
れています：ツールバー、Recent Projects（最近のプロジェクト）、ProVAL Online（インタ
ーネットがアクセス可能で、プログラム・オプション画面の『Show Online Content on the Start 
Page（スタート画面にオンライン接続を表示する）』が選択されている場合）。
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If the Internet is not available, the ProVAL Online section will be blank or on rare occasions, the “Action 
canceled” message will be displayed instead. 

Under Recent Projects are listed recently analyzed and saved projects.  The most recent unsaved project, if 
any, will be in the lower left corner: 

The Getting Started menu has the following features: 

New: Create a new project. 
Open: Open a previously saved project by specifying the path and filename. 
Clear History: Clear recent projects and unsaved projects. 

The Tools menu includes: 

Options: Allows you to customize several features of the application.  See the Options 
section for details. 
Screenshot: Store a screenshot of the entire application to the Windows clipboard. 
Help 

SaveLogs: Save event logs in zip format in order to report bugs or issues. 
User’sGuide: This opens the PDF version of the ProVAL User’s manual for viewing.
Support: Online help via the ProVAL website. 
About: About window to show version number and other information. 

The Recent Projects screen has the following features: 

List of recent projects and most recent unsaved project, if any. 

The ProVAL Online screen has the following features: 

Shows the latest news and upcoming workshops.  You can elect to turn this off in the 
Options. 
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インターネットが利用可能でない場合は、ProVAL Onlineのセクションは空欄になります。
またはまれに、『Action canceled（取り消されたアクション）』メッセージが代わりに表示さ
れます。

Recent Projectsの下には、最近、解析および保存されたプロジェクトのリストが表示されま
す。最も新しい未保存のプロジェクトがもしあれば、一番左下に表示されます：

Getting Startedメニューには次の機能があります：
New（新規）：新しいプロジェクトを作成します。
Open（開く）：場所とファイル名を指定し、以前保存したプロジェクトを開きます。
Clear History（履歴消去）：最近および未保存のプロジェクトを消去します。

Toolsメニューは次のとおり：
Options（オプション）：アプリケーションのいくつかの機能をカスタマイズすること
ができます。詳細については、Optionsの章を参照してください。
Screenshot（スクリーンショット）：ウィンドウズのクリップボードに全アプリケーシ
ョンのスクリーンショットを保存します。

Help（ヘルプ）
Save Logs（ログの保存）：バグまたは問題を報告するために zip 形式でイベント
ログを保存します。

User’s Guide（ユーザーガイド）：PDF版の ProVALユーザマニュアルを開きます。
Support（サポート）：ProVALウェブサイトによるオンライン・ヘルプ。
About（バージョン情報）：バージョン番号および他の情報を表示します。

Recent Projects画面には次の機能があります：
最近のプロジェクトおよび最新の未保存プロジェクトのリスト。

ProVAL Online画面には次の機能があります：
最新ニュースおよび予定されているワークショップを表示します。Options でこの機
能をオフにすることができます。
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Once a project has been created or opened, the Project menu contains the following items: 

Close Project: Close the current project. 
Add Files: Add profile data to the current project. 
Save: Save the current project or save as a different project.  
Report: Create a PDF, Excel or Text report. 
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プロジェクトを作成もしくは開くことにより、Projectメニューに次の項目が表示されます：
Close Project（プロジェクトを閉じる）：現在作業中のプロジェクトを閉じます。
Add Files（ファイルの追加）：現在作業中のプロジェクトにプロファイルデータを追
加します。

Save（保存）：現在作業中のプロジェクトを上書き保存あるいは名前をつけて保存し
ます。

Report（レポート）：PDF、エクセル、テキスト報告書を作成します。
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File and Project Management 

The file and project management in ProVAL is detailed as follows: 

ProVAL can open ProVAL project files and ProVAL-compatible profile data files. 
You may have multiple instances of ProVAL on the same computer.  Each instance of the 
software can have only one project open.  The same file or project cannot be opened in 
multiple instances. 
The project file (*.pvp) contains both project settings and profile data (stored in PPF formats 
- ProVAL’s native data format as well as the ASTM International standard format). 
Previous versions of projects (e.g., *.pv3, *.pv2, and associated *.ppf files) can be imported. 
Individual profile data files can be extracted in PPF format from the project file in the Viewer 
window. 
The project files can be opened using standard Windows techniques, including dialog boxes 
(i.e., via Open button on the home screen or Open menu from the application menu), drag-
and-drop (i.e., drag a project file from Windows explorer to the ProVAL application areas), 
most recently used (MRU) files (i.e., from the Application Menu/Recent Projects or simply 
clicking any recent project listed on the panel under the Getting Started of the ProVAL 
starting page), and file association (i.e., double-clicking a *.pvp, *.pv3, or*.pv2 file within the 
Windows explorer). 
Once a project is active, profile data files can be imported using the Add Files button on the 
toolbar or the drag-and-drop option (i.e., drag from Windows explorer to the ProVAL 
application areas). 
Profile data files can also be imported using file association (i.e., double-clicking any ProVAL-
compatible data files such as *.ppf, *.erd, etc. within the Windows explorer).  An “Untitled” 
project will be created automatically.  Users can then use Save As to save it to another 
filename or simply discard it (the latter is useful for a quick view of data without saving any 
projects). 
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ファイルとプロジェクトの管理

ProVALにおけるファイルとプロジェクトの管理について以下に詳述します：
ProVAL は ProVAL プロジェクト・ファイルおよび ProVAL 互換性のあるプロファイル
データ・ファイルを開くことができます。

同じコンピュータの上に ProVALの多数のウィンドウがあるかもしれません。ソフトウ
ェアの各ウィンドウは 1つのプロジェクトだけを開くことができます。同じファイルや
プロジェクトを多数のウィンドウで開くことはできません。

プロジェクト・ファイル（*.pvp）は、プロジェクト・セッティングおよびプロファイル
データ（PPF形式－ASTM国際基準形式と同様な ProVAL本来のデータ形式－で保存さ
れている）の両方を含んでいます。

旧バージョンのプロジェクト（例えば*.pv3、*.pv2および関連する*.ppfファイル）はイ
ンポートすることができます。

個々のプロファイルデータ・ファイルはビューア画面のプロジェクト・ファイルから

PPF形式で抽出することができます。
プロジェクト・ファイルは標準の Windows 機能を使って開くことができます。ダイア
ログ・ボックス（ホーム画面の Open ボタンやアプリケーションメニューの Open メニ
ュー）、ドラッグ・アンド・ドロップ（プロジェクト・ファイルをWindows Explorerか
ら ProVAL へドラッグする）、最近使ったファイル（アプリケーションメニューの最近
使ったファイル、あるいは ProVAL開始ページの Getting Startedの下にあるパネルにリ
ストされた最近のプロジェクトを単純にクリックする）、またファイルの関連付け

（Windows Explorer内の*.pvp、*.pv3、*.pv2ファイルをダブルクリックする)など。
プロジェクトを有効にすると、プロファイルデータ・ファイルは、ツールバーの Add 
Filesボタンかドラッグ・アンド・ドロップ（Windows Explorerから ProVALへドラッ
グする）でインポートすることができます。

プロファイルデータ・ファイルもファイルの関連付け（Windows Explorer 内の*.ppf、
*.erdなどの ProVALと互換性のあるデータ・ファイルをダブルクリックする）を使用し
てインポートすることができます。『Untitled（名称未設定）』のプロジェクトが自動的に
作成されるので、Save Asを使い名前をつけて保存するか、単に破棄します。(後者はプ
ロジェクトを保存せずにデータをすばやく表示します。) 
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Add Files 

You can use the Add Files button in the toolbar to select and add profile data files to the current project. 

A dialog box will appear when you click the Add Files button.  Files of the Default File Type set in the 
Options are displayed.  To view other file types, use the dropdown menu.   

ProVAL-Compatible File Formats 

ProVAL recognizes the following file types.  The file extension is listed in parentheses after the description: 

ProVAL 3.1+  Project and embedded data file (pvp) 
ProVAL 3.0 Project and embedded data file (pv3) 
ProVAL 2 Project (pv2) (note that the associated ppf files need to be within the same folder 
as the pv2 file) 
Pavement Profile File (ppf).  This is based on the native file specification of ProVAL.  It is a 
very efficient and secure format.  The latest ppf specifications can be downloaded from the 
ProVAL website.  This format is the basis for the ASTM Profile Data standard. 
ERD (erd): ProVAL recognizes both text formats, and the two 4-byte floating-point binary 
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ファイルの追加

ツールバーの[Add Files]ボタンを使えば、現在作業中のプロジェクトにプロファイルデー
タ・ファイルを選択・追加することができます。

[Add Files]ボタンをクリックすると、ダイアログ・ボックスが表示されます。Options 画面
にはデフォルトのファイル形式のファイルが表示されます。他の形式を表示するには、ドロ

ップダウンメニューを使用します。

ProVALと互換性のあるファイル形式

ProVALは次のファイル形式を認識します。括弧内はファイル拡張子です：
ProVAL 3.1+ プロジェクトおよび埋め込まれたデータ・ファイル（pvp）
ProVAL 3.0 プロジェクトおよび埋め込まれたデータ・ファイル（pv3) 
ProVAL 2 プロジェクト（pv2）（関連する ppfファイルが pv2ファイルと同じフォル
ダ内にある必要があることに注意) 
ペイブメント・プロファイル・ファイル（ppf）これは ProVAL本来のファイル・スペ
ックに基づく。それは非常に効率的で安全なフォーマットです。最新の ppfスペック
は ProVALウェブサイトからダウンロードすることができます。このフォーマットは
ASTMプロファイルデータ標準の基本です。
ERD（erd）：ProVALはテキスト形式および 2つの 4バイトの浮動小数点 2 進数フォ
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formats.  Information about the ERD files can be found on the UMTRI website 
(http://www.umtri.umich.edu/erd/software/erd_file.html).  The profile data and most of 
the header information are also imported. 
Dipstick (elv) files: They are Dipstick data in text format without any headers. 
KJLaw Text files (a*): These files usually end with file extensions such as "a01", "a02", etc. 
The profile data and most of the header information are also imported. 
KJLaw Binary files (p*): These files usually end with file extensions such as "p01", "p02", etc.  
The profile data and most of the header information are also imported. 
Dynatest RSP File (rsp): These files are generated by the field program of Dynatest Mark II 
or III (version 35.00 or above).  The rsp event markers and GPS information can be also 
imported. 
TxDOT (pro): ProVAL can import the newer TxDOT “pro” format.  Event markers will 
also be imported. 
Ames File (ard, adf, ldf,):  These are file formats (adf is newer than ldf) generated by the 
Ames profiler field programs.  The GPS information and event markers can also be 
imported. Additional event markers for the lead-in and lead-out locations may be added. 

It is possible that other file types could be added to the application’s importing capability in the future, as 
manufacturers and software developers make their file specifications available to the FHWA and the 
ProVAL development team. 

File Import Wizard 

ProVAL can also import generic files in text format using a File Import Wizard.  The generic text file needs 
to consist of profile data in column(s) and separated by a symbol. There shall not be blank lines or other 
non-data lines in the data block. The file headers are optional and will be skipped during file import.  It is 
recommended to inspect the data using a text editor and find out additional information about the profile 
before using the File Import Wizard. 

The steps to import such files are as follows: 

Use the Add Files button to start the Open file dialog box. 

Select “All Files” under the Files of type selection and select a generic text file.
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ーマットを認識します。ERD ファイルに関する情報は UMTRI ウェブサイト
（http://www.umtri.umich.edu/erd/software/erd_file.html）で見ることができます。プロフ
ァイルデータおよびヘッダー情報の大部分もインポートされます。

Dipstick（elv）ファイル：ヘッダーのないテキスト形式での Dipstickデータです。
KJLaw テキストファイル（a*）：これらのファイルは、通常『a01』、『a02』などのフ
ァイル拡張子で終わります。プロファイルデータおよびヘッダー情報の大部分もイン

ポートされます。

KJLaw 2 進数ファイル（p*）：これらのファイルは、通常『p01』、『p02』などのファ
イル拡張子で終わります。プロファイルデータおよびヘッダー情報の大部分もインポ

ートされます。

Dynatest RSPファイル（rsp）：これらのファイルは、Dynatestマーク IIあるいは III（バ
ージョン 35.00あるいはそれ以上）のフィールド・プログラムによって作成されます。
rspイベント・マーカーもインポートすることができます。
TxDOT（pro）：ProVAL はより新しい TxDOT『pro』フォーマットをインポートする
ことができます。イベント・マーカーもインポートされます。

Amesファイル（ldf、adf）：これらは、Amesプロファイラー・フィールド・プログラ
ムによって作成されたファイル形式（adfは ldfより新しい）です。ldf／adfイベント・
マーカーもインポートすることができます。起点と終点に対する追加イベント・マー

カーも追加されます。

メーカーとソフトウェア開発者が彼らのファイル・スペックを FHWA および ProVAL開発
チームに対して利用可能にすれば、今後、他のファイル形式がアプリケーションのインポー

ト能力に追加される可能性があります。

ファイル・インポート・ウィザード

ファイル・インポート・ウィザードを使用して、ProVALは一般的なテキスト形式のファイ
ルもインポートすることができます。テキストファイルは列記されたプロファイルデータ

から構成され、符号（カンマ、小数点）によって分けられている必要があります。データブ

ロックには空の行やデータではない行は存在しないものとします。ファイル・ヘッダーはオ

プションであり、ファイルインポート中はスキップされます。テキストエディタを使ってデ

ータを検査し、ファイル・インポート・ウィザードを使用する前にプロファイルに関する追

加情報を見つけ出すことが推奨されます。

ファイルをインポートする手順は次のとおりです：

[Add Files]ボタンを押して Openファイル・ダイアログ・ボックスを開きます。

File of type（ファイル形式）の選択肢から『All Files（全てのファイル）』を選び、テキ
ストファイルを選択します。
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A File Import Wizard will pop up with a table displaying the first 100 rows of information 
from the file.  Note that the File Import Wizard will also launch when the imported ProVAL-
compatible format is corrupted. 

Fill in information including: Sample Interval, Sample Interval Unit, Elevation Unit, Decimal 
Symbol, Data Starting Row.  As the correct Data Starting Row is selected, several selections 
of data types will be displayed depending on the number of columns in the data block. 
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ファイル・インポート・ウィザードが、ファイル情報の最初の 100列を表示するテーブ
ルを別ウィンドウで開きます。インポートされた ProVAL互換性フォーマットが破損し
ている場合は、ファイル・インポート・ウィザードが再び開きます。

これらを含む情報で（空欄を）埋めてください：Sample Interval（サンプル間隔）、Sample 
Interval Unit,（サンプル間隔の単位）、Elevation Unit（高さの単位）、Decimal Symbol（小
数点記号）、Data Starting Row（データ開始行）。正確なデータ開始行が選択されると、
データブロック中の列の数に応じたデータ・タイプの選択肢が表示されます。
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Select the correct data type from the following options for each data column: Left, Center, 
Right, Unknown Location, or Not a Profile. 
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各データの列に対して次のオプションから正確なデータ・タイプを選びます：Left（左）、
Center（中央）、Right（右）、Unknown Location（不明）、Not a Profile（プロファイルでは
ない）。
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Click Next> and Finished to import and save the file into the current project. 
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[Next>]をクリックしてインポートを終了すると、現在のプロジェクトにファイルが保
存されます。
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Basic Operation 

A step-by-step process for a typical viewing and analysis is as follows: 

Step 1: Start a new ProVAL project using the New button on the ProVAL home screen and 
it creates an “Untitled” project.  You can elect to save is as another file name. Let’s leave it 
for now. 
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基本操作

代表的な表示と解析のプロセスは以下のとおりです：

ステップ 1：ProVALホーム画面の[New]ボタンで新規の ProVALプロジェクトを始める
と、『Untitled（名称未設定）』のプロジェクトが作成されます。別のファイル名で保存す
ることができますが、今はそのままにしておきます。
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Step 2: Use the Add Files button on the ProVAL toolbar to select profile data to be 
imported. 

Step 3: After adding a file, a thumbnail of its profile will be added to the list with imported 
profiles available for selection. 
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ステップ 2：ProVALツールバーの[Add Files]ボタンを使い、インポートするプロファ
イルデータを選択します。

ステップ 3：ファイルを追加すると、そのプロファイルのサムネイルが選択可能なイン

ポートファイルのリストに追加されます。
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Step 4: Select or de-select the desired profiles by clicking the corresponding checkboxes.  
Selected profile traces will be displayed on the chart.  You can then proceed with viewing and 
analysis functions. 
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ステップ 4：対応するチェックボックスをクリックし、希望のプロファイルを選択、解

除します。選択したプロファイルが、グラフに表示されます。これにより、確認しなが

ら解析することができます。

ProVAL ユーザーガイド / 始める 



ProVAL User’s Guide / Getting Started 

Page 26

Report Functions 

The Report button, once clicked with a mouse, lists options for report functions.  Select the location and 
type of report.  The export functions include: Print to PDF, Export to Excel and Save to Text. 

Print to PDF:  Generate a secured PDF report. 
Export to Excel: Save report data to various Excel worksheets.  
Save to Text: Save report data in various text files.

Charts in the Viewer and some analysis screens can also be exported as images to either files or the 
Clipboard in the PNG format.  See Viewer and Analyses sections for details. 

Print to PDF 

After viewing profiles or finishing an analysis, you can click the Report button and select PDF to generate a 
“secured” PDF report that cannot be modified. 

If the option to use the alternate chart template is selected in the Options, the alternate chart colors will be 
printed.   
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報告書機能

Reportボタンを一度クリックすると、報告書機能のオプションが表示されます。報告書の位
置およびタイプを選択します。エクスポート機能は次のとおりです：Print to PDF（PDFに
印刷）、Export to Excel（エクセルへのエクスポート）、Save to Text（テキスト形式での保存）。

Print to PDF：安全な PDF報告書を作成します。
Export to Excel：様々なエクセルワークシートへ報告書データを保存します。
Save to Text：様々なテキストファイルで報告書データを保存します。

ビューアや幾つかの解析画面におけるグラフは、PNG 形式で画像としてファイルまたはク
リップボードにエクスポートすることもできます。詳細はビューアおよび解析の章を参照

してください。

PDFに印刷

プロファイルの確認や解析の終了後に、[Report]ボタンをクリックし、PDF を選択すると、
修正できない『保護された』PDF報告書が作成されます。

Optionsにおいて別のグラフテンプレートを使用するオプションを選択しておけば、別の色
で印刷されます。
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SI単位系を使う 

ログの記録を可能にする 

スタート画面にオンライン接続を表示する 

印刷や PDF報告書には別のグラフ色を使う 

報告書のフォルダ 
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The secure PDF has the following restrictions: 

Changing the document 

Document assembly 

Page extraction 

Commenting 

Filling of form fields (NA) 

Signing 

Creation of template pages 
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保護された PDFには次の制限があります：

文章の変更

文章の合成

ページ抽出

コメント

フォームフィールドへの記入（利用できない）

署名

テンプレート・ページの作成
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Export to Excel 

Chart and table data from all profile analyses can be exported Excel files by clicking the Report button and 
selecting Excel.  Select Include all data if you wish to include detailed results.  Each exported Excel file 
contains analysis results from a specific profile trace. 
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※作成した PDFファイルのプロパティ画面

Excelへのエクスポート

全てのプロファイル解析のグラフと表のデータは、[Report]ボタンをクリックし、[Excel]を選択し
て、Excelファイルをエクスポートすることができます。詳細な結果を加えたい場合に、Include all 
data（全てが含まれたデータ）を選択できます。それぞれのエクスポートされた Excel ファイルに
は、特定のプロファイルの解析結果を含みます。
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Users can launch the Excel application and open the ProVAL-exported Excel files.  For each worksheet 
within an Excel file, data will be arranged in columns with appropriate headings and units. 

Data in tables and charts will be saved to each worksheet for post processing (such as: plug in pay 
schedule for bonus/penalty computation).  Due to limitation of rows in Excel 2003 and earlier, you 
should be cautious when exporting data that exceeds 65,536 rows (including the data column 
headers).  Excel 2007 and later have a maximum of 1,048,576 rows.  Report charts will not be 
included in the exported Excel files.  However, you can use the ProVAL built-in screenshot tool 
button to export chart images to the Windows clipboard then insert into other documents or 
spreadsheets. 
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ユーザーは Excel アプリケーションを起動して ProVAL からエクスポートされた Excel ファイル
を開くことができます。Excelファイル内の各ワークシートのデータは、適切な見出しと単位で列
記されます。

表やグラフのデータは事後処理（たとえば支払予定のボーナスやペナルティを計算する機能を追加

するような処理）のために各ワークシートに保存されます。Excel 2003以前のもので行に制限があ
るものは（ヘッダーを含めてデータ列が）65,536行を超えるデータをエクスポートするときには注
意が必要です。Excel 2007以降のものは最大で 1,048,576行あります。レポートの図表には、エク
スポートされた Excel ファイルには含まれません。とはいえ、Windows のクリップボードにグラ
フ画像をエクスポートする ProVALのスクリーンショット・ツールボタンを使用して、他のドキュ
メントやスプレッドシートに挿入することもできます。
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Save to Text 

Chart and table data from all profile analyses can be exported to text files by clicking the Report button and 
selecting Text.  Select Include all data if you wish to include detailed results.  One or more files will be 
generated for the analysis results from the data sets.  
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テキスト形式での保存

プロファイルの解析による全てのグラフと表のデータは、[Report]ボタンをクリックし[Text]を選択
してテキストファイルにエクスポートすることができます。詳細な結果を加えたい場合に、Include 
all data（全てが含まれたデータ）を選択できます。1つ以上のファイルがデータセットからの解析
結果に対して作成されます。
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The text file names correspond to each data set.  The text files can then easily be viewed in any text editor or 
for any data submission or post processing. 
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テキストファイル名は各データセットに対応します。テキストファイルは簡単に任意のテキストエ

ディタを表示したり任意のデータ提出を事後処理したりすることができます。
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Utility Functions 

There are several utility functions in ProVAL for various purposes. 

A Screenshot Tool 

A built-in screenshot tool is included.  By clicking the Screenshot button on the toolbar, a screenshot of the 
entire application will be stored in the Windows clipboard.  You can then open any other Windows 
application (such as MS Word) and paste the screenshot there. 

A Copy-Table-to-Clipboard Tool 

By clicking any table results with the mouse while using the right mouse button, the entire table will be 
stored in the Windows clipboard.  Selecting Copy table to Clipboard includes the column headers.  
Alternatively, choose Copy table without column names.  You can then open any other Windows 
application (such as MS Word) and paste the table results there. 
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ユーティリティ機能

ProVALには様々な目的のためのユーティリティ機能がいくつかあります。

スクリーンショット・ツール

スクリーンショット・ツールが内蔵されています。ツールバーの[Screenshot]ボタンをクリックする
ことで、Windowsのクリップボードに保存されます。その後（例えばMS Wordなど）他のWindows
アプリケーションを開き、そこに貼り付けることができます。

クリップボードへの表コピー・ツール

マウスの右ボタンを使用しながら、マウスで任意の表の結果をクリックすることで、表全体が

Windowsのクリップボードに保存されます。Copy table to Clipboard（クリップボードに表をコピ
ーする）を選択すると、列ヘッダーが含まれます。あるいは、Copy table without column names（列
名なしで表をコピーする）を選択します。その後（例えばMS Wordなど）他のWindowsアプリケ
ーションを開き、そこに表の結果を貼り付けることができます。

※ 5章参照 pp.93～96 
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Options 

User preferences are divided into three areas: General Settings, Analysis, and Chart Color Templates. 

General Settings 

Under General Settings, you can change the following to fit your needs: 

Use SI Units: If checked, SI units will be applied to the application; if not, USCS units will 
be used. 
Enable Recording Log: If checked, event logs would be recorded.  Enabling this option is 
recommended and will enable Support to easier diagnose issues. 
Show Online Content on the Start Page: If checked, the ProVAL Online section will be 
displayed on the application home screen. 
Use Alternate Chart Template for printing and PDF reports: If checked, the chart 
format on the Alternate Chart Colors tab will be used when printing charts and creating 
PDFs.  If unchecked, the format on the Chart Style tab will be used.   
Default File Type: Used to set the default file type for the Add Files dialog box. 
Spreadsheet Program: ProVAL will automatically search for MS Excel and put the location 
of it here.  If Excel was not found or you prefer to use another program, you can browse for 
it here. 
Default Project Path: Very useful setting to allow you to quickly access profile data in a 
frequently used path. 
Bing Maps License Key: If you have your own license key for Bing Maps, you may enter it 
here. 
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オプション

一般的な設定、解析、チャートのカラーテンプレートの 3項目のユーザー選択があります。

一般設定

一般的な設定の下で、ニーズに合わせて、以下の項目を変更することができます。

Use SI Units（SI単位を使う）：チェックした場合は SI単位、しない場合は USCS単位がア
プリケーションに適用されます。

Enable Recording Log（ログの記録を可能にする）：チェックした場合、イベントログが記
録されます。問題診断のサポートを簡単に行うため、このオプションを有効にすることを

推奨します。

Show Online Content on the Start Page（スタートページにオンラインコンテンツを表示）：
チェックした場合、ProVALオンラインがアプリケーションのホーム画面に表示されます。
Use Alternate Chart Template for printing and PDF reports（印刷と PDFレポートに別のチ
ャートテンプレートを使う）：チェックすると、印刷したり、PDF を作成したりするとき
のグラフ形式として Alternate Chart Colors（別のチャートカラー）のタブが使用されます。
オフにすると、グラフスタイルはタブ上のフォーマットが使用されます。

Default File Type（ファイル形式）：ファイルを追加するダイアログボックスで表示される
既定のファイル形式を設定します。

Spreadsheet Program（表計算プログラム）：ProVALは自動的に Excelの場所を検索してこ
こに表記します。Excelが見つからないか、別のプログラムを使用したい場合は、[Browse]
で参照することができます。

Default Project Path（保有先）：頻繁に使用されるパスのプロファイルデータに素早くアク
セスできる非常に便利な設定です。

Bing Maps License Key：Bing Mapsの独自のライセンスキーをお持ちの場合は、ここに入
力できます。
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Analysis 

The following can be set using this utility: 

Default Analysis: Set the default analysis that is displayed on the toolbar for easy access. 
Selected Analyses: Any analyses that are checked will be displayed in the Analysis menu. 
Templates: Templates are saved input settings. 
Add from File…: Import a saved template (*.pvat, *.pv3at, or *.pvi) 
Add from ProVAL 3.4-: Import all existing templates from all ProVAL versions (3.4 and 
earlier) on the computer.
Export to File…: Export templates to a *.pvat file
Clear…: Clear existing templates.  Especially useful if they become corrupt. 

Page 34 

解析

以下はこのユーティリティを使って設定することができます。

Default Analysis（既定の解析）：簡単にアクセスするためにツールバーに表示される規定の
解析項目を設定します。

Selected Analysis（選択した解析）：チェックされているすべての解析は解析メニューに表
示されます。

Templates（テンプレート）：テンプレートは入力設定を保存します。
Add from File…（ファイルから加える）：保存したテンプレートをインポートします。（*.pvat、
*.pv3at、または*.pvi）
Add from ProVAL 3.4-（ProVAL 3.4以前から加える）：コンピュータ上のすべての ProVAL
のバージョン（3.4以前）からすべての既存のテンプレートをインポートします。
Export to File…（ファイルにエクスポート）：*.pvatファイルへテンプレートをエクスポー
トします。

Clear…（消去）：既存のテンプレートをオフにします。破損した場合に特に便利です。
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An example to import a template (*.pvat) file: 

An example to export a template (*.pvat) file: 

Page 35 

テンプレート（*.pvat）ファイルをインポートする例：
※[Options]にある[Analysis]の[Add from File]をクリックします。

テンプレート（*.pvat）ファイルをエクスポートする例：
※[Options]にある[Analysis]の[Export to File]をクリックします。
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検索条件に一致する項目はありません。

検索条件に一致する項目はありません。
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Chart Color Templates 

A default color template is provided.  A color template defines the chart’s background color, line styles, and 
axis fonts.  A line style specifies the line color, pattern, and thickness.  The template defined on the Chart 
Style tab is generally used.  If Use Alternate Chart Template is selected in the Options, the alternate chart 
colors are used when printing and generating PDF reports.   
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チャートのカラーテンプレート

規定のカラーテンプレートが提供されています。カラーテンプレートは、チャートの背景色、線の

スタイル、および軸のフォントを定義します。線種は、線の色、パターン（模様）、および太さを指

定します。通常は、チャートスタイルタブで定義されたテンプレートが使われます。オプションで

Use Alternate Chart Template（別のチャートテンプレートを使用する）が選択された場合は、PDF
レポートを作成したり印刷したりするときに別のチャートカラーが使用されます。
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Chart Controls 

A common chart is used throughout the software.  This feature helps you become familiar with consistent 
chart layouts.  Specific features include: 
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チャートの管理

共通のチャートがソフトウェア間で使用されます。この特色は、一貫性したグラフレイアウトに慣

れる手助けになります。具体的な機能は次のとおりです：
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Scroll Bars:  Both horizontal and vertical.  Only available when zooming into a portion of a 
chart. 

Zoom History (backward and forward arrows): Preserve the zoom history so that you can 
zoom back and forth, similar to back and forward buttons in a Web browser.  They will be 
activated (in green) only when zooming to certain levels. 

(Zoom) Scale (magnifier glass symbol): When entering this mode, the chart will set a zoom 
level equal to a predefined scale.  Predefined zoom scales are 0.1 miles, 0.5 miles, and 1 mile 
(or 0.1 km, 0.5 km, and 1.0 km if SI unit system is specified in the Options).  Zoom scales 
cannot be changed at this time.  

(Overview) “Full” (magnifier glass symbol with a frame): Show the full length of the chart.   

Panning: Allows you to ‘grab’ the chart using the right mouse button (the mouse icon would 
change into a “hand” symbol) and move it, instead of using the scrollbars. 
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Scroll Bars（スクロールバー）：水平および垂直の両方。グラフ部分にズームする時の
み使用できます。

Zoom History（ズーム履歴（前後矢印））：webブラウザボタンの戻る・進むと同様に前後
にズームできるようにズームの履歴を保存します。一定のレベルまでズームする場合のみ

（緑色で）有効になります。

(Zoom) Scale（(ズーム)スケール（虫眼鏡記号））：このモードに入るとグラフはあらかじめ
定義されたスケールに等しいズームレベルを設定します。定義済みの倍率は 0.1 miles、0.5 
miles、1 mileです（オプションで SI単位系を指定した場合は 0.1 km、0.5 km、1.0 kmで
す）。ズームスケールはこの時点で変更することはできません。

(Overview)“Full”（(全体を見渡す)全体（フレーム付き虫眼鏡記号））：グラフ全体を表示し
ます。

Panning（パンニング）：マウスの右ボタンを使用して（マウスのアイコンが『手』の記号
に変わります）、スクロールバーの変わりに、グラフを「つかんで」動かすことができます。
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Copy Image to Clipboard: Allows an image of the chart be exported to the Windows 
Clipboard. 

Save Image to File

  A dialog box would pop up for you to save the exported image as a PNG file. 

Print chart: Prints the chart using the standard or alternate chart template, depending on the 
Options setting. 
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Copy Image to Clipboard（画像をクリップボードにコピーする）：グラフの画像をWindows
のクリップボードにエクスポートすることができます。

Save Image to File（画像をファイルに保存する）：グラフの画像を PNG形式のファイルに
エクスポートすることができます。

PNG ファイルとしてエクスポートした画像を保存するためのダイアログボックスが
ポップアップ表示されます。

Print chart（グラフを印刷する）：オプションの設定に応じて、標準または別のチャートテ
ンプレートを使用してグラフを印刷します。
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Profile Selection 

A group of functions within the Profile Selection menu bar can be used to select one or more profiles. 

Select Channels 

Five buttons can be used to select all left channels, all middle channels, all right channels, all channels, as well 
as clear all selections.  This function is available in the Viewer and applicable analyses. 

Help and Event Log System 

Save Logs 

An event log is provided to record any errors that occur.  A Recording Log is provided to record all actions 
taken by you.  This is very useful for debugging.  You can opt to turn this off.  To save logs for submitting 
issues, you can use the application menu and select Help/Save Logs. 
A Save As dialog box would prompt for you to save the event log file in zip format to a selected folder.  
This file can then be submitted to the ProVAL support team to assist the diagnostics. 
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プロファイルの選択

プロファイル選択メニューバー内の機能群は、1つ以上のプロファイルを選択するために使用する
ことができます。

チャンネルの選択

5 つのボタンは、①左チャンネル、②中央チャンネル、③右チャンネル、④全チャンネル、⑤選択
解除、を選択するために使用します。この機能はビューアや適用可能な解析で使用できます。

ヘルプとイベントログ機能

ログの保存

イベントログは ProVAL の操作中に発生したプログラムエラーを記録するために設けられている。
記録ログはユーザーによって行われたすべてのアクションを記録するために設けられている。これ

はデバッグのために非常に便利です。これをオフにする選択ができます。問題を送信するためのロ

グを保存するために、アプリケーションメニューを使用して Help/Save Logs（ヘルプ/ログの保存）
を選択することができます。

Save As（名前をつけて保存）のダイアログボックスを選択したフォルダに ZIP 形式のイベントロ
グファイルを保存するように促す。このファイルは診断を補助するために、ProVAL サポートチー
ムに提出することができます。
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User’s Guide 

An electronic User’s Guide (this document) in PDF format can be viewed through the Help menu of the 
Home screen. 

Release Notes 

The release notes in PDF format for this version of ProVAL can be viewed through the Help menu of the 
Home screen.  This document includes new features, changes, and known issues.   

Support 

Clicking the Support menu under Help will launch the default web browser on your computer and load the 
ProVAL homepage. 

About 

Clicking the About menu under Help will display the About window that consists of the information about 
the version of ProVAL running, the link to the ProVAL webpage, etc. 
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ユーザーガイド

PDF形式の電子ユーザーガイド（本書）はホーム画面の（ヘルプ）メニューで表示できます。

更新履歴

ProVALのこのバージョンで PDF形式のリリース情報には、ホーム画面のヘルプメニューで表示で
きます。この文書には、新しい機能、変更、既知の問題が含まれています。

サポート

ヘルプ内のサポートメニューをクリックすると、コンピュータ上の既定の web ブラウザを起動し、
ProVALホームページをロードします。

バージョン情報

ヘルプ内のアバウトメニューをクリックすると、使用している ProVALのバージョンや ProVALウ
ェブページ等へのリンクについての情報で構成されているウィンドウが表示されます。
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